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Copyright 
 
All rights are reserved.  No part of this document may be reproduced or transmitted in any form or 
means electronic or mechanical including photocopying and recording or by any information 
storage or retrieval system except as may be permitted in writing by Civica Education Pty Ltd.  
  
Application for permission for use of copyright material, including permission to reproduce extracts 
in other published works, shall be made to the publishers.  Full acknowledgement of author, 
publisher and source must be given. 
  
Material is contained in this publication for which publishing permission has been sought and for 
which copyright is acknowledged. Permission to reproduce such material cannot be granted by the 
publishers and application must be made to the copyright holder. 
  
Microsoft, Windows and Excel are registered trademarks of Microsoft Corporation.  Visual 
Components is a trademark of OMNIS Software Limited.  Integris is a trademark of RM Plc. 
  
Because our policy is to improve our products and services continually, we may make changes 
without notice.  We have tried to keep the information in this manual complete and accurate, but 
we cannot be held responsible for the consequences of any errors or omissions. 
  
Your comments are of great value to us in improving our computer systems, publications and 
services. 
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property of Civica Education Pty Ltd and its associates. All rights are reserved except as may be 
granted to the addressee in writing by Civica Education. 
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Training Outcomes 
 
At the conclusion of Cover training, participants will be able to: 
 

 Enter teaching subjects into Staff Details 

 Add Subject Area Parameters 

 Add internal and external relief staff to the Relief Register and edit their details 

 Edit staff availability for relief 

 Flag teaching periods as not requiring relief (timetabling schools only) 

 Add and edit Reason for Absence parameters 

 Enter and edit staff absences 

 Assign relief teachers to cover staff absences 

 Produce a range of Cover reports 
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Training Program 
 

Time Content 

8.30 am/12.30 
pm 

Coffee and Registration 

8.45 am/12.45 
pm 

Introductions 

File Menu 

Overview of Administration Manager 

 Staff Detail 

 Parameters – Subject Area 

Overview of Timetabling (Timetabling schools only) 

 Timetable Cycles 

 Timetabling Reports 

Cover 

 Relief Register  

 Parameters 

 Staff Absences 

10.15 am/2.15 
pm 

Morning/Afternoon Tea 

10.30 am/2.30 
pm 

Cover 

 Assigning Relief Staff 

Cover Allocation 

Cover Reports 

Review 

11.45am/3.45 pm Close 
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1 Getting Started 

1.1 Introduction 

These notes are intended as a reference during training with RM Asia-Pacific in the use of the 
Integris Cover module.  It covers all the main sections of the software and guides users through its 
main functions. 
 
The Cover Module offers schools the ability to allocate relief cover when members of staff are 
known to be absent.  Due to the nature of staff relief, staffing and timetabling are important 
considerations.   

1.2 Logging on to Integris 

In order to log on onto Integris a user name and password is required.  School Administrators set 
up users and allocate user access rights to various modules of Integris. 

Note: See the Integris Administration Manager manual for advice on setting up user access 
rights 

 

Activity: Logging On 
 

 To log on, double click on Integris Training on the desktop  

 Type ADMIN as the User Name  

 <Tab> and enter the password keys 
 

 
 

 Click on Login or press <Enter>  
 

 

Note:  For assistance with user names and passwords, please see the Integris 
Administration Manager Manual or access Help from the top tool bar that gives 
comprehensive Help contents.  
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1.3 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 
Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 
 
Change User should be used to ensure that each person accessing Integris does so under their 
own user name and with their personal levels of access. 
 
Lock Terminal may be used if the user needs to leave his or her computer temporarily, does not 
want to log off and does not want to allow access to anyone else.  Unlocking the terminal requires 
the user to enter his or her password again 
 
Report Destination allows the user to choose where to send any report created in Integris.  The 
options are displayed below. 
 

 
 
 

Activity: The File Menu 

Top Toolbar > File 

View each of the following items in the File menu 

 Password 

 Change User 

 Lock Terminal 

 Report Destination 
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1.4 Accessing Help 

Activity: Accessing Help 

Top Toolbar > Help > Help Contents and Index 

 Click Help in the top toolbar 

 Select Help Contents and Index 
 

 
 

 Highlight Integris Cover Help 

 Click Help 

 View the Cover  manual  

 Close the manual and Help 
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2 Introduction to Administration Manager 
Administration Manager is the basis of the Integris software.  Users of the Cover module will need 
to be aware of these particular functions within the Administration Manager to be able to work 
effectively in Cover:  
 

 Staff Details 

 Parameters - Subject Areas 

Note: If more information is required regarding Administration Manager, attending the 
Administration Manager training program is recommended. 

 

2.1 Staff Details 

General > Staff Details 

Administration Manager can hold details on both students and staff.  The staffing section of the 
system is accessed via the Staff Details icon on the General side bar.  Functionally it is very similar 
to the student window, using many of the same icons. 
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2.1.1 Entering Staff Details 

To add a new member of staff click Add.  The following window will appear, enabling users to 
enter relevant information.  
 

 
 

To edit a staff member’s details, locate their record and click on Edit.   
 
Mandatory fields are: 

 Surname 

 First Name 

 Date of Birth 

 ID Number 

 Staff Code 
 
It is also be good practice to include:  

 Title 

 Gender 

 Staff Type 

 WACOT number 

 Teaching details 

Note: Teaching details are not used by the Timetabling module but they are used by Cover. 
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Activity: Staff Details 

General > Staff Details 

 View the Personal   and Teaching   details for Elaine Abbott 
 

Enter yourself as a new member of staff.  

 Click Add    

 Enter the following information about yourself, tabbing between the fields: 
o Title 
o Surname * 
o First Name * 
o Gender 
o Date of Birth * 
o Staff Code *  (first three letters of your surname and your first initial) 
o ID Number 
o Staff Type  

Note:  * indicates the field is mandatory 

 

UDI – WACOT Number 

WACOT is the Western Australia College of Teachers.   
 

 Click on the UDI tab  

 Highlight WACOT Number 

 Click on the Edit UDI    

 Enter the WACOT number  
 

 
 

 Click OK to save the WACOT number  
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Entering Subject Information 

 Select the Teaching tab 

 Highlight the subjects that you can teach on the right and click   

 Select your main subject on the left and click   

Note:  Entering subjects here informs the Cover Module but not the timetable.  Hence it is 
good practice to enter subjects for relief teachers here, but subjects for teachers on staff 
should be entered into Timetabling > Timetable Setup > Staff Preferred Subjects 

 Click OK to save the Staff Details entered  
 

 
 

2.2 Parameters 

2.2.1 Subject Area 

General > Parameters > Subject Area  

Use the Add  and Edit  to add or edit subject areas. 
 

 
 

Note: Subject Area may be used to indicate a relief teacher’s area(s) of specialisation in the 
Relief Register in the Cover module. 
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Activity: Adding a Subject Area 

General > Parameters > Subject Area  

 Click Add  

 Add Health Education as a Subject Area 
 

 
 

 Link it to the Learning Area H&PE 

 Click in Locked  

 Click OK to save 

 Close Subject Area and Parameters 
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3 Introduction to the Timetabling Module (Timetabling Schools 
only) 

The Timetabling module facilitates the creation of a timetable and allows the efficient day-to-day 
maintenance of the timetable.  It also informs the Cover module which periods and teaching sets 
need be covered when teachers are absent. 
 

3.1 Timetabling Terminology and Concepts 

The TIMETABLE is a tool that enables the resource needs of the school to be managed. A 
school’s timetable is a plan of the student’s time, which indicates the subject being studied, its 
location, the teacher taking the class and the frequency of the subject. The subject choices of 
students need to be satisfied within the constraints imposed by the limited resources of teachers 
and rooms. 
 
The TIMETABLING YEAR holds all of the school’s timetabling activity within the school year.  
Integris will store past, present and future timetables enabling users to move between timetables. 
Within a timetable year, a CYCLE contains information regarding Cycle dates and period 
structures drawn from the school calendar and connects with the Lesson Attendance module.  
Cycles can be defined for each logical or physical CAMPUS. Students grouped together for 
timetabling reasons are identified as a COHORT and students may belong to multiple cohorts. 
 
GRIDS are the focus of timetabling activity and can be created or cloned from previous years. All 
Staff, rooms and subjects can be made available or unavailable, where required, to a grid.  The 
grid provides the framework within which the teaching sets required to satisfy the selections of 
students within the grid will be placed. 
 
Grids are made up of BANDS, which are similar to gridlines, but are divided up into BAND 
RECORDS.  Band records can be individually manipulated and ultimately represent a single 
occurrence of that combination of teaching sets on the timetable. 
 
Student PREFERENCES (subject selections), as well as reserve preferences, may be allocated, 
individually or in bulk, selected from groups or promoted from the previous year. 
 
Grids may be created manually or by using the AUTO-SCHEDULER or using a combination of the 
two to add some fixed elements.  The auto-scheduler can take into account a wide range of 
constraints when determining the optimal solution. 
 
Grid manipulation is referred to as MODELLING, and a comprehensive set of tools is available to 
assist with the modelling process from horizontal and vertical representations of the grid.  
Modelling can be used to construct a grid manually, as in Fixed Grid schools or to manipulate the 
output from the auto-scheduler. 
 
Grids are assigned to one or more SCHEDULES.  Schedules have a defined period of activity and 
a TIMETABLE will be a combination of all events active at a particular time.  
 
Each period of time for which the timetable remains unchanged is known as a TIMESLICE.  The 
timeslices required by the timetable are calculated automatically by the system by examining each 
of the schedules linked to grids. 
 
The timetable applicable to any date during the year can be selected by choosing the appropriate 
timeslice from a list of date ranges provided. 
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3.2 Timetable Cycles 

Timetabling > Timetable Setup > Timetable Cycles 

At least one timetable cycle must be defined for each timetabling year and contains the details of 
the cycle dates and period structures the school will use.  The timetable cycle draws details from 
the school calendar and forms a connection to the Lesson Attendance Year and the Cover module.  
 

 
 
Cycles may remain in use for a number of years or may change from year to year.  A cycle will be 
linked to the timetabling year via the grids that use it and may be cloned and/or edited for use in 
future years.  The number of days within a cycle is unlimited.  If a 5-day cycle is chosen the day 
names will default to Monday, Tuesday etc.  If any other cycle is chosen the day names will default 
to Day 1, Day 2 etc.  The day names are editable if required.  Cycle details may be added 
progressively over time.  A row refers to a line on the timetable and this may be a teaching period 
or a break, for example lunch.  Therefore 5 rows per day may indicate 5 teaching periods or any 
combination of teaching periods and breaks, for example 3 teaching periods, lunch and recess. 
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Activity: Viewing the Timetable Cycles 

Timetabling > Timetable Set up > Timetable Cycles 

 
 

 Highlight 2010 - 5 and click Edit  in the top right of the screen 

 View the cycle definition, then click Cancel to close 
 

 View the Master Period Structure tab 

 Click Display Preview  to view the period structure graphic, then close 
 

 View the Staff Availability tab 

 Close Timetable Cycles and Timetable Set up 
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3.3 Timetabling Reports  

Timetabling > Reports 

Timetabling reports are located within the Report option on the Timetabling sidebar. 
 

        
 
Reports that may be useful when organising teacher relief are located in the Operational & 
Maintenance Reports – Staff folder. 
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Activity: Viewing Timetabling Reports 

Timetabling > Reports > O&M Reports – Staff > Staff Timetable 

 Select the current TT Year , Cycle and Date Range 

 Click Find 

 Select Harris Barclay and Sandra Corner 

 Click OK to select them both 

 Click Print 
 

 
 

 Double click on the Screen icon to view the reports 

 Close the reports 
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Timetabling > Reports > O&M Reports – Staff > Staff Load 

 Select the current TT Year , Cycle and Date Range 

 Click the Find by Department radio button and select English from the Department drop-
down menu 

 Select A3 Paper 

 Click Print 
 

 
 

 Click Transpose report layout and Print again 
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4 Cover 
The Cover Module offers schools the ability to allocate relief cover when members of staff are 
known to be absent.  Due to the nature of staff relief, staffing and timetabling are important 
considerations.   
 

4.1 The Cover Sidebar 

The Cover sidebar gives access to the following menu options: 
 
 
 
 Staff Absences - Clicking this icon will open the ‘Staff Absences’ window that 
will allow users to view, add, edit and delete staff absences  
 
Cover Allocation - Clicking this icon will open a window that will allow users to 
allocate cover for absent staff.  
 
 
Relief Register - Clicking this icon will open a window that will allow users to 
view, add and edit relief staff members.  
 
Parameters - Clicking this icon will open a window that will allow the user to 
select a parameter to edit.  
 
 
Reports - Clicking this icon will open the reports submenu from which you can 
run general Cover reports. 
 
 
 
 
 

4.2 Relief Register 

Cover > Relief Register 

The Relief Register is accessed by clicking Relief Register on the Cover Sidebar. 
 
The Relief Register holds all the information for the Internal and External relief staff.   
 
For internal relief, all personal information and qualifications is drawn from General > Staff Details.  
These members form the Internal Relief Staff Pool.  Change of personal details for internal relief 
staff must be made through General > Staff Details (See Administration Manager Manual) which 
will then be carried through to the Cover Module.  Willingness to undertake paid relief, Load Status, 
Subject Specialisations, Cover Periods and Availability may all be edited in this window. 
 
Individuals who form the External Relief Staff Pool will have all of their personal information and 
qualifications added through this window.  All details for the External Relief Staff are managed 
through this module. 
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This window has four panes: 
 

 Personal Information - displays contact details, reference number and any special notes 
associated with that person.  Fields marked with an asterisk (*) are compulsory fields, no 
changes will be saved unless these fields have been completed. 

 

 
 

 Qualifications/Skills - displays the staff member’s academic qualifications and the subjects 
that he or she is qualified to teach.  For external relief teachers, these may be added from the 
school’s list of available subjects.  Subject area specialisation may also be added for both 
internal and external relief teachers. 
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 Cover Periods – displays the relief periods that have been allocated to the individual, whether 
they are payable or not and, if payable, the status of payments, and whether or not feedback 
on the relief was provided.  This pane can be filtered to show cover periods within a particular 
date range and to display All, Paid or Unpaid Cover periods. 

 

 
 

 Availability- is recorded for all relief staff members.  By default all staff members are displayed 
as being available all day from Monday to Sunday.  Users may change a staff member’s 
AM/PM availability.  
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Activity: Viewing/Editing the Relief Register (1) 

Cover > Relief Register > Personal Info 

 Click Edit  

 View the Personal Info tab for Elaine Abbott, note which fields are editable 
 

 
 

 Enter a Load Status of -0.20  (that is; Elaine Abbott is two periods a week under load) 

 Click OK to save 
 

 

Note: The teacher load status is visible for internal relief staff only.  It is a manually entered 
value.  It is used to indicate whether or not the internal staff member has time available 
during the week to provide relief.  A + or – symbol indicates whether the teacher is under or 
over load. 

The number entered here will be a manual calculation made by the school based on the 
Teaching Load and Full Load.  For example, an entry of -2 means that the staff member is 
under load by 2 periods. An entry of + 2 will mean the staff member is over load by 2 
periods. 

There are two ways to update the load status.  Firstly, from the Relief Register and 
secondly, from the Availability Bulk Entry window, which is accessible from Parameters.   
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Activity: Viewing/Editing the Relief Register (2) 

Cover > Relief Register 

 Click the Qualifications/Skills tab,  

 Click Edit     

 Note which fields on each tab are editable 
 

 
 

 Highlight English in the Available Specialisations pane and click  
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 Select the Cover Periods tab 

 Change the From date to 1 February and click Find Relief Days  
 

 
 

 Click on the tick in the Feedback column to read the note 

 Click OK to close the note 

 Click in the Payable and Paid column for 10 February 
 

 

 Click the Availability tab 
 

 
 

 Highlight Saturday and click Change AM  

 Repeat to Change PM 
 

 Click OK to save the changes you have made 
 

 Click Print  to view the relief teacher’s records 
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4.2.1 Adding Relief Staff  

New Relief staff members can be added to the Register by clicking on the Add  button on the 
Relief Register Tool bar.  The user must determine whether the new member who is being added 
to the register, is an external relief teacher or an internal relief teacher. 
 
When adding an internal relief teacher, he or she must first be added to the Staff Details in 
General > Staff Details.  When adding an external relief staff member, all details are entered 
directly into the Relief Register. 
 
 

Activity: Adding Internal Relief Staff 

Cover > Relief Register 

 Click Add  on the Relief Register toolbar 

 Choose the radio button for Internal Relief Teacher /Staff and click OK 
 

 
 

 

 Click in the Staff list generated and press <Crt> + <A> on the keyboard to select all the staff 
members 

 Click OK 
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Note:  Most of the information in the Personal Info and Qualifications/Skills may only be 
updated via the General > Staff Details window.  Most of Internal Relief Staff details cannot 
be edited in the Relief Register 

 

Activity: Adding External Relief Staff (1) 

Cover > Relief Register 

 Click Add  on the Relief Register toolbar 

 Choose the Radio button for External Relief and click on OK 
 

 
 

 Enter the Personal Information (see below) for the new staff member.   
 

 
 

 



 
Integris Cover Training Notes.docx8-Jul-15 

Page 30 of 83 

© 2015 Civica Education Pty Ltd 
 

 

Note:  The Staff Type field is not editable as this choice is made earlier in the process of 
entering new relief staff.   

All fields marked with a red asterisks  are compulsory.  No data may be saved until 
these fields have been completed.  Clicking on OK to save prior to completing this 
information will generate an error message prompting the user to enter information in the 
required field/s. 

 Click Qualification/Skills 

 Click Add a Qualification  

 Select a Qualification from the drop-down menu and enter the date attained 
 

 
 

 Click OK 

 Highlight Mathematics and Science in the Available Specialisations pane 
 

 
 

 Click  

 Highlight Science in the Specialisations column and click Major  
 

 
 

 Highlight Mathematics and click Minor 
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 Select the Availability tab 
 

 
 

 Highlight Wednesday and click  

 Repeat and click  

 Repeat for Saturday and Sunday 
 

 Click OK to save the changes 
 

 
 

4.2.2 Locating Relief Staff Members 

There are a number of options available to the user for locating staff on the Relief Register. 
 

 Use the Select Relief Staff type drop-down menu 

 Use the Navigation buttons 

 Use the Find Relief Staff button 
 

Activity: Locating Relief Staff 

Cover > Relief Register 

 To select Relief Staff using the drop down menu, click on the down arrow and 
select ERT 

 

 
 

 Use the Navigation Arrows   to scroll through the list of External Relief Staff 
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 Click Find Relief Staff   

 Enter the search criteria from below and click Find 
 

 
 

 Click the Firstname column header to sort by first name 
 

 
 

 Click Print Find Results   

 Double click on the Screen icon 

 Name your report and click OK 
 

 
 

 Close the report but leave the Cover Staff Find open 

 Click Back 
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 Click Save current find settings as a query   

 Name your query and click OK 
 

 
 

 Clear your search criteria  

 Click View the Query List  
 

 Click  

 Select Female Internal Relief and click Load 

 Holding down <Ctrl> select about six staff members and click Select 
 

 
 

 Click Next  to scroll through the browse set 

 Click  and Yes to clear the browse set 

 Click Next again 
 

 

Activity: Recap Relief Register  
 

 Add a new external relief teacher   
 
Their major teaching area is Physical Education and their minor is Society and Environment.  
They are not available for relief on Friday afternoons. 
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4.3 Cover Parameters 

Cover > Parameters 

The Cover parameters are accessed by clicking on the Parameters button on the sidebar.  This 
window lists all available parameters within the Cover module. 
 

 
 
 

4.3.1 Availability Bulk Entry 

Cover > Parameters > Availability Bulk Entry 

 
 
The teacher Load Status is a manually entered value.  It is used to indicate whether or not the 
internal staff member has time available during the week to provide relief.  A + or – symbol 
indicates whether the teacher is under or over load.  The number entered here will be a manual 
calculation made by the school, based on the teaching load and full load.  For example, an entry of 
-2 means that the staff member is under load by 2 periods. An entry of + 2 will mean the staff 
member is over load by 2 periods. 
 
There are two ways to update the load status.  Firstly, from the Relief Register and secondly, from 
the Availability Bulk Entry window, which is accessible from Parameters.   
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Activity: Availability Bulk Entry 

Cover > Parameters > Availability Bulk Entry 

 Double click on Availability Bulk Entry 

 Click Find  

 Select Relief Type IRT and click  
 

 
 

 Holding down <Ctrl> select about six staff members and click Select 
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 Highlight all teachers in the list 
 

 
 

 Enter a Load Status of -0.20   

 Click Update   
 

 Highlight all teachers in the list 

 Check Willing to undertake paid relief    

 Click Update   
 

 Close the Bulk Load Status Update window 
 

 Leave Parameters open 
 

 

4.3.2 Exclusion Planner (Timetabling Schools only) 

Cover > Parameters > Exclusion Planner 

Some timetabled periods may not require relief due to a temporary suspension of a part of the 
timetable.  This may be due to an excursion, assembly, sports carnival, examinations etc. 
 
The exclusion planner allows the user to exclude parts of the timetable for relief allocation.  The 
main window displays the date when the exclusion will occur, the timetabling teaching sets that will 
be excluded and any special comments that need to be entered for that date. 
 

 
 



 
Integris Cover Training Notes.docx8-Jul-15 

Page 37 of 83 

© 2015 Civica Education Pty Ltd 
 

Relief Day Notes 

The note may be a reminder of events, such as sports day, and will assist the relief planner when 
they are selecting relief staff.  The note will appear on the Select Relief window at the bottom and 
will be read only. 
 

Activity: Exclusion Planner 

Cover > Parameters > Exclusion Planner 

All Year 8 students are attending an all-day excursion on 6 December, so no relief will be 
required to cover any Year 8 classes on that day. 
 

 Double click Exclusion Planner in the Parameters list 
 

 Click the Select a date  and, using the single red arrow pointing to the right, scroll to 
December, select 6th and click OK 

 

 Click Add an exclusion  

 Enter the following information 
 

 
 

 Click OK 
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 Click OK 
 

 Click   

 Close the Exclusion Planner window 
 

 
 

4.3.3 Reason for Absence 

Cover > Parameters > Reason for Absence 

The Reason for Absence parameter is accessed by double clicking on Reason for Absence in 
the Parameters window.  
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Reason for Absence Toolbar 

 Modify/Add Parameter- allows the user to edit existing unlocked parameters and to add 
new ones. 
 

 Delete Selected Parameter- enables the user to delete selected parameters, provided 
they are unlocked and not in use. 
 

 Toggle Active Property - allows the user to make selected active parameters inactive, 
provided they are unlocked and not in use, or to make inactive parameters active, provided they 
are not locked. 
 

 Toggle Locked Property - enables the user to unlock selected locked parameters and to 
lock selected unlocked parameters. 
 

 Print Parameters – prints the parameters list to the desired report destination. 

Note: The Default setting UNKNOWN cannot be unlocked nor made inactive and therefore 
cannot be edited. 
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Activity: Editing/Adding Reasons for Absence  

Cover > Parameters > Reason for Absence 

 Highlight S - Illness  

 Click Toggle Locked Property  and Yes 

 Click Modify/Add Parameter   

 Change the Description from Illness to Sick 

 Press <Tab> 

 Enter EL under Code and press <Tab> 

 Enter Exam Leave under Description and press <Tab> 
 

  
 

 Enter F and Family Leave 

 Click OK 

 Highlight the unlocked parameters and click Toggle Locked Property  and Yes 

 Leave the Reason for Absence window open 
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Activity: Deleting a Reason for Absence 

Cover > Parameters > Reason for Absence 

 Highlight S - Sick and click Delete  

Note: Locked parameters may not be deleted. 

 Click Toggle Locked Property   and Yes and Delete  

Note: Active parameters may not be deleted. 

 Click Toggle Active Property  

Note: Parameters in use may not be made inactive 

 Click Toggle Locked Property  
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Activity: Making a Reason for Absence Inactive 

Cover > Parameters > Reason for Absence 

 Highlight EL - Exam Leave and click Toggle Locked Property   

 Yes to the message 

 Click Toggle Active Property   

 Check Only show active entries, noting Exam Leave is no longer visible 
 

 
 

 Uncheck Only show active entries 

 Highlight Exam Leave and click Toggle Active Property   

 Click Toggle Locked Property    and Yes 

 Leave the Reason for Absence window open 
 

 

Activity: Printing Reasons for Absence 

Cover > Parameters > Reason for Absence 

 Click Print Parameters   

 Print the report to the screen 

 Close the report 

 Close Reason for Absence 
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4.3.4 Type of Leave 

Cover > Parameters > Type of Leave 

The Type of Leave window is pre-populated with the HRMIS leave codes.   
 

 
 

Activity: Viewing Type of Leave 

Cover > Parameters > Type of Leave 

 Double click on Type of Leave in the Parameters window 

 View the types of leave 

 Close Type of Leave and Parameters 
 

 
 

Activity: Recap Parameters 
 

 Mark all the female internal relief teachers as being available for paid relief 
 

 
On the 2nd December all Year 9 students are attending an end-of-year excursion. 
 

 Exclude all Year 9 classes on that day from relief planning 
 

 

 Add a new Reason for Absence: Jury Duty - ensure the new parameter is active and locked 
 

 
  



 
Integris Cover Training Notes.docx8-Jul-15 

Page 44 of 83 

© 2015 Civica Education Pty Ltd 
 

4.4 Staff Absences   

Cover > Staff Absences 

Clicking Staff Absences on the Cover sidebar will activate the Staff Absences window. 
 
When the Staff Absences window is activated, it will default to the current date and display all staff 
members who have been entered into the system as being absent on that day, the reason for the 
absence, whether a medical certificate has been received and who the assigned relief teacher will 
be. 
 

 
 
When viewing historical, current and future records, days that are in the past will be shaded light 
grey, while current and future records will be shaded white. 
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The records in Staff Absences can be sorted by clicking on any one of the column headings. A 
single click on a column heading will sort the column by ascending/descending order depending on 
the data in the column. 
 

4.4.1 Staff Absences Tool Bar 

 Date Selector – allows the user to change the From and To dates 

 Refresh View – refreshes the Staff Absences window after the date range has been 
changed 

 Add Staff Absence – enables the user to enter a new staff absence 

 Edit Staff Absence – enables the user to edit a staff absence 

 Delete Staff Absence – enables the user to delete a staff absence 

Note:  Only current and future absences may be deleted. 

 Assign Relief Staff – opens the Assign Relief window for selected staff 

 Print Relief Advice – prints the Relief Staff Allocation Advice for selected absences. 
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Activity: Viewing/Editing Staff Absences 

Cover > Staff Absences 

 Click the Select From Date  and select 1 February 

 Click the Select To Date  and select TODAY 

 Click Refresh View  
 

 
 

 Click on each of the column headings to sort by Staff Member, Date, Reason and Relief 
Member 

 

 
 

 Highlight Harris Barclay  and 18 February 

 Click Edit Staff Absence   
 

 
 

 OK to the message 
 

 Change the Reason to S and the Leave Code to SCK-W/O MED TCH 
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 Click OK 
 

 

 Highlight all entries for Travis Elliott  and click Assign Relief Staff   

 View the relief allocation for 10 February 

 Click Next Date  and view the relief allocation for 11 February 

 Repeat for 12 February 

 Close the Assign Relief window 

 Leave the Staff Absences window open 
 

 

 Highlight all entries for Travis Elliott  and click Print Relief Teacher Advice   

 Send the report to the screen 

 View the report 

 Close the report 

 Leave the Staff Absences window open 
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Activity: Adding a new Staff Absence for the Entire Day 

Cover > Staff Absences 

 Click Add Staff Absence   

 Click Find Staff   

 Click   to search for all staff members 

 Highlight Harris Barclay, Jennifer Calvin and William Davids 
 

 
 

 Click Select and Yes 

 Enter TODAY’s date as the From and To dates and leave the reason as UNKNOWN 
 

 

Note: Double check that the From date is TODAY. 

 Click OK 

 Close the small Staff Absences window 
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Activity: Adding a new Staff Absence for Selected Periods 
Only 

Cover > Staff Absences 

Sharyn Oswald has a doctor’s appointment this morning. 
 

 Click Add Staff Absence   

 Click Find Staff   

 Type OSWA in the Name/Number field and click   
 

 
 

Timetabling schools 

 Enter TODAY’s date in From and To and check Period   

 Click Select Periods   

 Select periods H and any other morning periods 

 Click Add Period  
 

 
 Click OK 
 



 
Integris Cover Training Notes.docx8-Jul-15 

Page 50 of 83 

© 2015 Civica Education Pty Ltd 
 

Non-timetabling schools 

 Enter TODAY’s date and uncheck PM  
 

 
 

 

 Click Add Reason   
 
The Parameters - Reason for Absence window will open. 
 

 Click Modify/Add Parameter  

 Enter Code M and Description Medical appointment and click OK 
 

 
 

 Highlight M Medical Appointment and click Toggle Locked Property   

 Close Parameters - Reason for Absence 

 Enter the following information  
 

 

Note: Double check that the From date is TODAY. 

 Click OK 

 Close the small Staff Absences window 
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Activity: Deleting a Staff Absence 

Cover > Staff Absences 

 Highlight Jennifer Calvin’s  absence for TODAY 

 Click Delete    and Yes 
 

Note: Only current and future absences may be deleted. 

 

4.5 Assign Relief Staff  

Cover > Staff Absences > Assign Relief Staff 

Relief staff can be assigned in the same window as absent staff are entered. 
 

4.5.1 The Assign Relief Window 

Cover > Staff Absences > Assign Relief Staff 

This window will allow the user to allocate relief staff to one or more periods for absent staff 
members, print the relief advice reports and a summary of relief staff allocations. 

Assign Relief Toolbar 

 Assign Relief Staff - opens the Assign Relief Teacher window where the user can select 
from available internal or external relief staff 
 

 Print Relief Advice - prints the Relief Advice Notice which details the relief periods to be 
covered and the teaching set details 
 

 Print Relief Summary – creates a report identical to what is visible in the Assign Relief 
window 
 

 Navigation keys - on either side of the date field, are activated when 
multiple dates are selected from the Staff Absences list.  Users may scroll backwards and forwards 
through the selected dates by clicking on the blue arrows 
 

  Save Details – saves the relief allocation details entered. 
 
The Assign Relief window displays the selected absent staff member(s) and the periods that 
require cover. Any cell in the window that is greyed out does not require cover. Cells shaded blue 
have already had a relief teacher assigned; cells shaded green are marked ready for relief teacher 
assignment and the white cells are awaiting any action by the user. 
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The Assigned Relief cell may be used to allocate the same teacher to all periods requiring cover. 
This process does not require each individual cell to be marked for assignment as marking the 
Assigned Relief cell will mark all cells requiring cover and apply the selected relief teacher.  This 
may be useful when an external relief teacher is to be employed. Whereas marking individual cells 
may be more suited to the use of internal teaching staff to cover individual relief periods. 
 

Assign Relief Drop-Down Menu 

Cover > Staff Absences > Assign Relief Staff 

Right clicking in a cell in the assign relief window will display the following menu: 
 

 
 

 Mark Cell - will shade the cell green ready for assigning a relief teacher 

 Un Mark Cell - will undo the previous action of marking a cell prior to a relief teacher being 
assigned 

 View Details - will display period details for the active cell 
 

 
 
The door icon in this window is the Select Room button and allows the user to change the room 
allocation for the relief period. 
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Note: View Details will be greyed out in non-timetabling schools 

 View Teaching Sets – displays the teaching set members in the teaching set to be covered  
 

 

Note: View Teaching Set will be greyed out in non-timetabling schools 

Add/Edit Note – allows instructions to be provided to the relieving teacher for the specific teaching 
set to be entered.  The note will hold a maximum of 1000 characters. 
 

4.5.2 Assign a Relief Teacher: 

Cover> Staff absences 

 Enter the date range for which you wish to allocate relief 

 Click Refresh View   
 

 
 

 Highlight the staff members for whom you want to assign relief 

 Click on Assign Relief Staff   
 
If no absence record is highlighted then a message will appear. 
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If the multiple staff members are chosen and they are not from the same timetabling cycle, a 
message will appear prompting the user to select staff from the same timetabling cycle. 
 

 
 
If all selected staff members are from the same timetable cycle, a grid will be generated showing 
the timetable for the absence records selected. 
 

 
 

To assign a relief teacher to an absent staff member: 

Cover> Staff Absences > Assign Relief 

 Click in the Assigned Relief cell at the end of the row for the absent teacher to make it active 

 Right click to activate the drop down menu and choose Mark Cell. All cells requiring cover will 
be shaded green 

 

 
 

 Click on Assign Relief Staff  to activate the list of available relief teachers 
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Contact information, availability, specialisations, number of periods taught (IRT only), number of 
relief periods already allocated during the current day and week, total number of relief periods 
already undertaken, available load and whether or not staff are willing to undertake paid relief (IRT 
only), and total number of hours of relief undertaken (ERT only). 
 
All fields may be viewed by using the scroll bars across the bottom of each window. 
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 Highlight the preferred relief teacher from the available staff pool, his or her name will be added 
to the Selected Relief Staff Members field 

 Click Assign 
 
The highlighted cells will now be shaded blue and the Relief Teacher’s name displayed in all 
relevant cells 
 

 
 

 Click Save and a confirmation message will be generated 

 Click OK 
 

To assign a relief teacher on a per period basis: 

Cover > Staff Absences > Assign Relief Staff 

 Click in the first cell for assignment to make it active  

 Right click to activate the drop down menu  
 

 
 

 Click Mark Cell to paint the cell green  

 Click on the Assign Relief Staff  button to activate the list of available relief teachers  
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 Highlight the preferred relief teacher from the available staff pool and the teacher’s name will 
be added to the Selected Relief Staff Members field  

 Click Assign and the assigned teacher’s name will now display for the selected period only  
 

 
 

 Repeat the process for all other periods requiring cover  

 Save the changes before closing the window  

Note:  Assigning relief on a period by period basis will not fill the Assigned Relief cell.  If 
you choose to use this cell, only one primary relief staff member can be chosen. 
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Activity: Assigning Relief (Timetabling schools) 

Cover > Staff Absences 

 Highlight Harris Barclay and William Davids’ absences for TODAY 

 Click Assign Relief Staff   

 Right click in Barclay’s first teaching period and select View Teaching Sets 
 

 
 

 Close Teaching Sets 
 

 

 Right click in Barclay’s first teaching period and select Add/Edit Note 
 

 
 

 Enter a note and click OK 
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 Right click in Barclay’s Assigned Relief cell and select Mark Cell 
 

 
 
All Barclay’s teaching periods will be shaded green. 
 

 Click Assign Relief Staff  
 

 
 

 Using the scroll bars, view all of the available information in both windows 

 Select the external relief teacher Relief Teacher and click   
 

 

 Right click in the first teaching period for William Davids and select Mark Cell 

 Click Assign Relief Staff   

 Highlight an internal relief teacher and click  

 Repeat for each of Davids’ teaching periods 

 Click  and OK 
 



 
Integris Cover Training Notes.docx8-Jul-15 

Page 60 of 83 

© 2015 Civica Education Pty Ltd 
 

 

 Check Insert Page Break  

 Click Print Relief Advice   

 Send the report to the screen, view and then close  
 

 Click Print Relief Summary   

 Send the report to the screen, view and then close  
 

 Close Assign Relief 
 

 
 

Activity: Assigning Relief (Non-timetabling schools) 

Cover> Staff Absences 

 Highlight Harris Barclay  and William Davids’ absences for TODAY 

 Click Assign Relief Staff   

 Right click in Barclay’s AM cell and select Add/Edit Note 
 

 
 

 Enter a note and click OK 
 

 

 Right click in Barclay’s Assigned Relief cell and select Mark Cell 
 

 
 
Both Barclay’s AM and PM Cells will be shaded green. 
 

 Click Assign Relief Staff   
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 Select the external Relief Teacher and click   
 

 

 Right click in AM for Davids and select Mark Cell 

 Click Assign Relief Staff   

 Highlight an internal relief teacher and click   

 Repeat for Davids’ PM session 

 Click  and OK 
 

 

 Click Print Relief Advice   

 Send the report to the screen, view and then close  
 

 Click Print Relief Summary   

 Send the report to the screen, view and then close  
 

 Close Assign Relief 
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Activity: Recap Staff Absences  
 
Jennifer Calvin is attending SIS training next Monday and Tuesday. 
 

 Enter her absence and assign relief for both days 

 Print the Relief Allocation Advice 
 

 
Tabitha Swindon has urgent private business next Wednesday afternoon. 
 

 Enter her absence and assign relief  

 Print the Relief Allocation Advice 
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4.6 Cover Allocation 

Cover > Cover Allocation 

The Cover Allocation window is accessed by clicking on Cover Allocation on the 
Cover sidebar. 
 
Cover Allocation is used to assign relief staff to absent staff members.  This area is only for 
assigning relief staff to absences and cannot be used to record staff absences.   
 

4.6.1 The Cover Allocation Window 

Cover > Cover Allocation 

When the Cover Allocation window is opened it will default to the current date and display all Staff 
absences recorded for that date. 
 

 
  



 
Integris Cover Training Notes.docx8-Jul-15 

Page 64 of 83 

© 2015 Civica Education Pty Ltd 
 

4.6.2 Cover Allocation Toolbar 

 Assign Relief Staff - allows the user to assign a relief member from either the internal 
relief staff pool or the external relief staff pool.  This function is also available in the Staff Absences 
Window.  (See Section 4.5) 

 Print Relief Advice - prints the relief details for the selected record(s).  This function is also 
available in the Staff Absences window and the Reports Window.  (See Sections 4.5.1 and 0 
respectively.) 

 Print Relief Summary - prints a summary of all the reliefs allocated to selected record/s.  
All selected records must be from the same timetable cycle.  This function is also available from 
the Staff absences and Reports windows.  (See Section 4.5.1 and 4.7.3 respectively.) 
 

 Search Criteria - allows the user to enter the date range 
required by using the date selector to the right of each of the From and To date fields. 
 

 Refresh View - refreshes the screen after setting search criteria (date range). 
 
Filter List - provides a number of options for displaying data to meet the user’s needs.  Records 
may be filtered by: 
 

 Relief Assigned 

 Relief Unassigned 

 Staff Member  

 Reason for Absence 
 

 
 
Once the criteria have been entered, the screen can be refreshed by pressing the Filter button. 
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Activity: Filtering the Cover Allocation List 

Cover > Cover Allocation 

 Click the Select From Date   

 Select 1 February 

 Click the Select To Date   

 Select next Wednesday 

 Click Refresh View   
 

 From the Filter List, select Relief Unassigned.  
 

 
 

 Click   
 

 From the Filter List, select  Show All 
 

 Click   to view all absences and relief cover 
 

 From the Staff Member drop down list, select Harris Barclay 
 

 
 

 Click  to view all Harris Barclay’s absences 
 

 Reset Staff Member to ALL and click   to view all staff absences 
 

 

 From the  Reason for Absence drop down menu, select S and click   to view all 
absences due to illness 

 

 
 

 Reset Reason for Absence to ALL and click   
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4.6.3 Assign a Relief Teacher: 

Note: See Section 4.5.2 for details on assigning relief 

Activity : Assigning Relief  

Cover > Cover Allocation 

 Click the Select From Date   

 Select TODAY’S date and click OK 

 Click the Select To Date   

 Select TODAY’S date and click OK 

 Click Refresh View   

 Highlight Sharyn Oswald and click Assign Relief Staff   

 Right click in her first teaching period and select Mark Cell   

 Click Assign Relief Staff   

 Select an internal relief teacher and click   

 Repeat for all other periods requiring relief 
 

 Click  
 

 Click Insert Page Break 
 

 Print Relief Advice  

 Close Assign Relief window 
 

 

 Highlight all of today’s absences  

 Click Print Relief Summary  

 Close the report 
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Activity: Recap Cover Allocation 
 
Sandra Corner is absent today. 
 

 Enter her absence in Cover > Staff Absences 

 Allocate her relief in Cover > Cover Allocation  

 Print a Relief Advice 
 

 

4.7 Cover Reports 

Cover > Reports 

There are four types of Cover reports: 

 Relief Teacher Reports 

 Relief Reports  

 Staff Reports 

 HRMIS Reports 
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4.7.1 Standard Cover Report Features 

All Cover Reports have two standard features: 

 Report title and footer  

 Date selector 

 Report field sorting.  
 

4.7.2 Printing Cover Reports 

 Click on the required folder icon  

 Click on the required report title.  The report criteria window will open 
 

 
 

 Edit the heading if required 

 Enter a footer if required 

 Select the required date range 

 Enter other appropriate report criteria  

 Highlight the name(s) of the teacher(s) about whom the information is required 

 Select appropriate sort options as required 

 Click Print.   

Note: The print button at the bottom of the reports window is disabled until a report is 
selected.  

The standard Report Destination window will open. 
 

 Select the required report destination 

 Click OK to print or Cancel to abort printing the report. 
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4.7.3 Relief Teacher Reports 

Cover > Reports > Relief Teacher Reports 

Activity: Payment Claim 

Cover > Reports > Relief Teacher Reports > Payment Claim 

The Payment Claim report lists, for a given date range, the periods relief staff who are flagged 
for payment have worked and whether each period is Non-Payable, Not Paid or Paid 
 

 
 

 Click the Select From Date    and select1February 

 Click Find 

 Highlight all the relief staff displayed 

 In Sort Options, double click on Surname  

 Click Print 

 Send the report to the screen 

 Close the report 
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Activity: Relief Staff Payment Summary 

Cover > Reports > Relief Teacher Reports > Payment Summary 

The Payment Summary report prints details of all the relief provided for a certain date range and 
whether that relief was Non-payable, Not Paid or Paid.  

Note: This report is applicable to timetabling schools only. 

 
 

 Click Select From Date  and select 1 February 

 Click Find 

 Highlight all the relief staff displayed 

 In Sort Options, double click on Date  

 Click Print 

 Send the report to the screen 

 Close the report 
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Activity: Relief Staff Register 

Cover > Reports > Relief Teacher Reports > Register 

The Relief Staff Register report enables the user to print information about teachers who have 
provided relief for a given date range.  Items available to be reported on are: 
 

 Contact Information 

 Notes 

 Qualifications 

 Staff Preferences 

 Cover Periods 
 

 
 

 Double click on Surname in Sort Options 

 Leave the date range as TODAY 

 Check all items for inclusion in the report 
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 Click the Relief Selector tab 

 Click Add a Relief Staff Member   

 Click Find 

 Holding down <Ctrl> select Elaine Abbott and Relief Teacher 

 Select and Yes 
 

 
 

 Print the report to the screen 
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4.7.4  Relief Reports 

Activity: Allocation Advice 

Cover > Reports > Relief Reports > Allocation Advice 

The Allocation Advice provides information to relief teachers on the teaching periods they will be 
covering.  If Include Teaching Set List is checked, then the teaching set lists are also provided.   
 

 
 

 Leave the date range as TODAY 

 Click Find 

 Check Include Teaching Set List and Insert Page Break (timetabling schools only) 

 Highlight all the relief staff displayed 

 In Sort Options, double click on Surname  

 Print the report to the screen 
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Activity: Allocation Summary 

Cover > Reports > Relief Reports > Allocation Summary 

The Allocation Summary will print out all periods of absence for a selected date range and cycle, 
and, provided relief has been assigned, the names of the relief teachers covering each period.  

Note: This report applies to timetabling schools only. 

 
 

 Leave the date range as TODAY 

 Click Find 

 In Sort Options, double click on Surname  

 Print the report to the screen 
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Activity: Relief Teacher Advice 

Cover>Reports > Relief Reports > Relief Teacher Advice 

 
 

 Leave the date range as TODAY 

 Click Find 

 Check Include Teaching Set List and Insert Page Break (timetabling schools only) 

 Highlight all the relief staff displayed 

 In Sort Options, double click on Surname  

 Print the report to the screen 
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Activity: Relief Allocation Summary 

Cover>Reports > Relief Reports > Relief Allocation Summary 

 
 

 Leave the date range as TODAY 

 Click Find 

 Highlight all the relief staff displayed 

 In Sort Options, double click on Period  

 Print the report to the screen 
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4.7.5  Staff Reports 

Cover > Reports > Staff Reports 

Activity: Staff Absence Report 

Cover > Reports > Staff Reports > Staff Absence Report  

The staff absence report provides details of all staff absences for a given date range.  It 
includes: 

 Absent teacher’s names 

 Dates of absence 

 Reasons for absence 

 Whether or not the absent teachers provided medical certificates 

 Periods and teaching sets covered 

 Names of relief teachers assigned to cover the absences 
 

 
 

 Click Select From Date  and select 1 February 

 Click Find 

 Leave the Reason as ALL 

 Highlight all the staff members displayed 

 In Sort Options, double click on Surname  

 Print the report to the screen 
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4.7.6 HRMIS Reports 

Cover > Reports > HRMIS Reports 

These reports may be used to help the administrator transfer data between SIS and HRMIS in 
relation to Cover. 
 

Activity: Staff Absence Summary Report 

Cover > Reports > HRMIS Reports > Staff Absence Summary Report 

 
 

 Leave the date range as TODAY 

 Click Find 

 Leave the Reason and Leave Code as ALL 

 Highlight all the staff members displayed 

 Sort by Surname 

 Print the report to the screen 
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Activity: Relief Payment Summary Report 

Cover > Reports > HRMIS Reports > Relief Payment Summary 

 
 

 Enter the From Date as 1 February 

 Click Find 

 Leave the Reason and Leave Code as ALL 

 Highlight all the relief staff displayed 

 Sort by Surname 

 Print the report to the screen 
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Activity: Relief Allocation Summary 

Cover > Reports > HRMIS Reports > Relief Allocation Summary  

 Click Select From Date  select 1February 

 Click Find 

 Select Group by Department (unavailable to non-timetabling schools) 

 Select Group by Leave Code 

 Highlight all the staff members displayed 
 

 
 

 Print the report to the screen 

 Close the report 
 

 Select Group by Absent Teacher and Group by Leave Reason 

 Print the report again 

 Close the report 
 

 Close Cover Reports 
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Activity: Review 

Complete each of the following activities noting where you went in the software to do it.  

1. The Year 10 students are going on an excursion next Friday.  Enter this into the Exclusion 
Planner. 

 
 
 
 

2. Enter about six absences of varying lengths and reasons for next week.  For one of the 
absences, add a new Absence Reason at the same time as adding the absence. 

 
 
 
 

3. Allocate relief to the teaching periods requiring cover next week.  Use a mix of internal and 
external relief teachers. 

 
 
 
 

4. Print Relief Teacher Advices (with teaching set lists if applicable) and a Relief Allocation 
Summary for next week. 

 
 
 
 

5. Enter the relief to be done next week by the external relief teachers and one of the internal 
relief teachers as payable and paid. 

 
 
 
 

6. Print the following reports for next week: 
 

 Relief Payment Summary  
 
 
 

 Staff Absence Report  
 
 
 

 Relief Allocation Summary Absent Teacher and Leave Code 
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5 Support  

5.1 WA 

Should you require support please contact the Customer Service Centre (CSC) at the Department 
of Education. 
 
Contact details below: 
 

Phone (CSC) 

Metro:   9264 5555 
Country:  1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 

Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 
 

5.2 NT 

Should you require support please contact the following: 

DEET SAMS Support  

Email  sams.deet@nt.gov.au 
Or Call DEET Hotline 8999 3531 
Or Fax SAMS/DEET 89995611 
Or Web Site  http://www.latis.net.au/sams/ 
 
 

mailto:customer.service.centre@education.wa.edu.au
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